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THE NATIONAL ANTHEM

Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga
Tava subha name jage,

Tava subha asisa mage,

Gahe tavajaya gatha.
Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,

Jaya he, jaya he, jaya he,

Jaya jaya jaya jaya he!

PLEDGE

India is my country. All Indians are my
brothers and sisters.

I love my country, and I am proud of its rich
and varied heritage. I shall always strive to
be worthy of it.

I shall give my parents, teachers and all elders
respect, and treat everyone with courtesy.

To my country and my people, I pledge my
devotion. In their well-being and prosperity
alone lies my happiness.
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Preface

Dear learners,

The Information and Communications Technology textbook for
Standard IXis prepared and presented to you with the firm conviction
that the ICT textbook for Std VIII was successful in guiding you across
the marvellous and ever advancing world of information and
communications technology and in providing you with various
innovative learning experiences.

You have already learnt the basic lessons of Graphic Designing.
This textbook has been prepared with the intention of providing you
with practice in using graphic software for designing posters and pictures
by yourself for curricular and extracurricular activities, familiarizing
you with the various possibilities of word processor, equipping you to
use software like spreadsheet, presentation, etc. for doing various
activities including projects.

The activities included in this textbook are designed using various
interactive software like GeoGebra, RasMol, GPlates, Stellarium, etc.
which will help you to get a deeper understanding of the various
concepts. The textbook also initiates you into the world of computer
languages by providing opportunities to prepare programs using
Python. In addition to familiarising the various services provided
through internet, the textbook also offers practice in handling Wiki
software.

This textbook that provides you with interesting and novel learning
experiences will prove to be a good companion to you in the learning of
other languages and subjects.

Dr. J. Prasad
Director
SCERT, Kerala
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Layout of Pictures

“Imagination is the source of every form of human achievement.”

- Ken Robinson

Every year June 12 is observed as the World Day
against Child Labour as per the directive of the
International Labour Organisation which is an agency of
the United Nations. Varsha and Saleena are having a
discussion on the Poster Designing competition to be
held in the school in connection with the World Day
against Child Labour. They decide to design a poster
with the help of their computer highlighting the slogan
“Education for All”.
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Layout of Pictures

You can also design attractive posters using pictures,
logos etc. with messages against child labour. You may
be aware of the fact that numerous graphics software are
available which will help you in this. We have already
learnt in the chapter The Wonderland of Pictures in
Standard VIII how the image editing software GIMP can
be used to prepare cover page, logos, etc.

What all features of the graphic software GIMP do
you know? Let’s list them.

GIMP helps to;

¢ Create copies of images.
¢ Separate the parts of images.

¢ Include letters in the picture.

Shall we design a poster using GIMP software? What
are the preparations to be done before designing a poster?

¢ Collect pictures required for preparing the poster in
your computer.

¢ Provide suitable background colour for the poster.

¢ Include all the pictures/images or parts of the images
based on the topic, on a canvas in such a way that
they communicate the idea.

¢ Make the poster attractive using the provisions in
Image Editing.

¢ Include a message in the poster.
Activity 1.1 Let’s collect pictures

Download the pictures necessary for the poster from
the Internet and save them in the Images folder of your
class folder. Ensure that your class folder is there in
Students_Work_9 folder in Home.

s ///////%

Image editing

The process of making
changes in an image with
the help of a software is
called image editing.
Today, it is possible to
create your picture as
standing fearlessly in the
deep forest with wild
animals around. Such
pictures are prepared
using Image editing
software. Software like
this can be used to crop
images, resize them,
change the colour and to
combine images. The
same image editing
software can also be used
to create characters for
animation. GIMP,
Photoshop, Krita, Picasa,
Image Magic, etc. are
some Image Editing
software.

Where will 1
get the
pictures from?

Er
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Layout of Pictures

What are the other methods in which you can collect
pictures? Let’s list some of the methods you have learnt
in your previous classes.

¢ Capture pictures using digital camera and save them
in the computer.

¢ Scan pictures and news clippings that appear in

Ilustration of the structure of newspapers and ma ga zines.
the folder in which the file is to
be saved O ettt ettt b et Rea ettt e s et et et e s et et esenereetens
O ettt R Rt R A a ettt e e s et b e b st e s nananaenes

A poster that creates awareness/communicates a
message can be designed suitably by arranging the words
and images appropriately. A canvas is essential in GIMP
to arrange the images and letters. So you can open GIMP
and create a canvas. Don’t you remember how a canvas

Size of the canvas is created using GIMP?

In GIMP, the size of the
canvas is measured in | reelbs Telopion %
pixel units. In addition to
pixels, you can also Y mi L@
select canvas in other |4 # &
units like centimeter, ::%
i11i , inch, . '

millimeter, i1nc etc o2
- Y

L]

GNU Image Manlpulation Program

Create a New Image -

from Create a New Image

window. Here (in Fig. Template: [ A4 (200pp) -]

1.1), a canvas of A4 size  |gwdo ""':':"E;JE_
. Wi 5 e
is created. There are elghts (29701 2, [mm 3

2480 = I50E pixels
B = 300 poi, RGS color

many templates
prepared and stored in | e i a3
GIMP in the similar Be_==is
manner. You can also '
create a canvas by

providing values in
Width and Height boxes Activity 1.2 - Let’s colour the canvas

» Advanced Options
) st (_corce ) D

Fig.1.1 Window and toolbox for creating a new canvas in GIMP

in the window. Imagine that the poster you are going to design,
should contain a background colour which is a
combination of two colours. Using the hints given,
provide a suitable background to the canvas you have
created.

Information and Communications Technology - IX 7/
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Layout of Pictures

¢ Select the suitable foreground and background colour  Sgve your Canvas with the
using the Foreground & Background colors tool. ™ file name Poster in your

¢ C(Click on Blend tool and then drag and apply colour inleng

to the canvas.
Activity 1.3 - Arrange pictures on the canvas

The poster is designed using one or more pictures.
So, you will have to bring the pictures one by one to the
GIMP canvas. Open the picture you would like to include
in the canvas first from the pictures you have already  Selection tools
collected. Don’t you remember how pictures can be

opened in GIMP? Now, do you need the whole picture
or only a part of the picture for your poster? You can use
the selection tool to select either the whole picture or part

|

CaUN N
R K3

of the picture. Observe the various selection tools in
GIMP (Fig.1.2).

Now, let’s see how a part of the picture is selected
and pasted on the canvas.

YAE 1L
‘e NB RN
BNJNu®

Don’t you see a white logo in Fig. 1.3? The areas in

the image with the same colour can be selected on the 1
basis of colour using the Select by Color tool. You may Fig.1.2
follow the steps given below: GIMP Toolbox

¢ Open the picture in GIMP.

¢ Click on the Select by Colortool ™8 in the toolbox to

activate it.

¢ (Click on the colour you wish to select from the picture.
(Here the picture is the logo of ILO). You can
see that all the white coloured areas have been [
selected.

¢ Click on the Edit menu of the picture window
and select Copy (Fig. 1.3).

¢ Click on the Edit menu of the canvas window ' :
you have'prepared for the poster and. select Fig. 1.3 E dit Window
Paste. (It is better to keep the canvas window
open right from the beginning).

%
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Floating layer/
Floating selection

Floating layers/floating
selections are temporary
layers that have the same
features of a normal layer.
A floating layer persists
only till layer editing is
done or till you begin the
next layer editing. To
anchor the image pasted
on the floating layer to
the background or the
selected layer click on
Anchor tool in the Layer
menu.

to anchor a Qar

REAvELO
Fig.1.4 Floatinglayer

%
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Layout of Pictures

Now, you have pasted the pictures on the GIMP
canvas. When the pictures are pasted on the canvas, they
appear on the canvas with a floating layer or floating
selection. (Fig. 1.4) By clicking on the Anchor tool in the
Layer Palette, you can avoid the floating selection and
fix the picture to the background.

Now, try to move the picture you have pasted on
the canvas. You can use the Mowve tool.

Were you able to change the position of the pasted
picture? Does the background move along with the
picture?

What may be the reason for this? Here, the picture is
pasted on the background.

If you wish to skip the last action and go back to an earlier
action, click on Edit — Undo of the canvas.

To edit the pictures we have pasted on the canvas, it
is better to use the provision of Layer in the Image Editing
software. To understand more about layer, read the note
on Layer editing.

Now, you might have understood that the pictures
moved freely because they were not pasted using layer.

Shall we try to do this activity by pasting the
previously copied image on a new layer according to the
instructions given below?

¢ DPaste the copied image on the canvas of the poster.
¢ Click on To New Layer in the Layer menu.

Now, what change has taken place in the Layer
palette? You can see that the picture is pasted on a new
layer.

You must specially note that in this case, there was
no need to anchor the picture.
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Layout of Pictures

Layer editing

Layers are an inevitable part of any Image Editing software. Each layer exists
independently. Usually, in image editing we have to process several images at the
same time. In such circumstances, if each image is arranged in a separate layer,
they can be edited independently.

To add new layers, click on the icon in the Layer Palette (Fig. 1.6). The

portion which has the tools required for creating and copying layers is the Layer
Palette. Duplicate layers can be prepared and the position of layers can be changed
using the various tools available in the Layer Palette. Normally, transparent layers
are used in GIMP to create new layers (Fig. 1.7). If the Layer Palette is not visible in
GIMP then, select Dockable Dialogs from the canvas Windows menu and click on

Layers.
canvasecf-1.0 (RGE color, 2 layers) 248023508 - GIMP -0 Layers L] NBWI.I,B!' ‘
File Edit- Select View Image Layer Colors: Tools Filters Fanllulr\r 5:r|pt-l=.| ng—; = ——
e o pow = H; Create a New Layer .
1 o |Mode: Mormak = canvas.xecf-1
pacity 1000
5 Layer name: [bayer I
lock: ¥ |.|

5 = Hoating Seteétion width: 8.267 B
0 G {Pasted Layer) . =
; wige: [ [o|[m_:)
] @ . Background g m
: Layer Fill Type
1 To create a new layer
3 () Foreground color
] To change the position of () Background color
] floating selection Lo fad ) .
. To copy a layer O White
] Ta anchar
| a floating
[ lav
. — % [Cnelo ] [cancel J[_ox_]

| = || 125% : Pasted Layer (84.9 ME} o] @ | " " ‘!ﬂl e

Fig. 1.5 GIMP canvas Fig. 1.6 Layer Palette Fig. 1.7 Layer Properties window

You are already familiar with the Select by Color tool.

Now, open the pictures you have collected and with
the help of the selection tools, select the parts of the picture
required. Using the Copy and Paste tools, insert the
pictures as various layers in the poster window.

Observe the uses of other Selection tools in GIMP
and complete Table 1.1. When you place the mouse
pointer on each tool in the selection box, the features of
the tool will appear as tool tips.

Information and Communications Technology - IX
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Layout of Pictures

Selection tool Short cut key Uses

Rectangle Select R To select in rectangle shape

Ellipse Select [ .| sttt sn s saaanes

FIEE SELOCE [ ceeeieeiiie ] e e et e e e teves s e se s s s e seeasassseessssseeasssssssasasasseen

Fuzzy Select ..........................................................................................................................

Select by (@0 () R IO TSR

Scissors Select

Foreground Select

Table 1.1 Short cut keys and uses of selection tools

You can create a new layer just before pasting the
copied picture. For this, click the icon Create a new layer
on the Layer Palette before pasting the picture. (Fig. 1.6)

You have included all the pictures required for the

poster, haven’t you? Now, using Move tool, arrange the
Do not Forget!!! pictures in suitable places.

After each action do not
forget to click on the Save
button in the poster
window to save your
work.

Changing the size of the picture as required will
make the poster more beautiful and attractive. To change
the size of the picture, activate the Scale tool and then
click on the picture. Now, provide the necessary
measurements as length and width and click on the Scale
button.

After arranging the required pictures for the poster
on the canvas, observe the Layer Palette (Fig. 1.9). You
know the layer in which the background is pasted. But,
what about the other pictures? Can you make out on
which layers they are placed? Providing names related
to the picture to each layer will make image editing
easier. To find out how a new name is given to a layer,
do the following activities.

%
Information and Communications Technology - IX
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Layout of Pictures

*posterxcf-1.0 (RGB color, 5 layers) 2480x3508 - GIMP. -oe
ﬂtﬂ Select m Image M m—ﬂ ﬁﬁ_t FX-Foundry m‘
1009

Tl |

—sereny

i ot T

o
px 2 || 12.5% 2 Pasted Layer #1 (1784 MB) B WA w o @

Fig.1.8 Poster Fig.1.9 Layer Palette

Activity 1.4 - Let’ thel .
ctivity et’s rename the layer How can we find out

¢ Open the Layer Palette. in which layer is each
picture pasted?
¢ Right click on the layer to be renamed. (You can also o
double click on the layer.) 0

¢ Select Edit Layer Attributes.

¢ Type anew name in the place of the existing name in
the window that opens up.

¢ Click on the OK button.
Activity 1.5 - Place a logo in the poster

By including a suitable message, we can make the
poster more communicative and catchy. Did you notice
that the message ‘Say No to Child Labour” in the poster
(Fig.1.8). This has been done using the provision of Logo
in GIMP. You have learnt how to create logos in your
previous class, haven’t you?

Amil faced a difficulty when he tried to include the
logo in the poster using Copy, Paste features. The
problem was that he could not paste all the parts of the
logo on the canvas. Why did this happen? Let’s find out.

Observe the Layer Palette in the Logo window. (Fig.
1.11) Can’t you see more than one layer? When we copied
the logo, only the active layer was copied.

Information and Communications Technology - IX
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Layout of Pictures

*[Untitied]-1.0 (RGE color, 3 layers) 1205x177 = GiMP — {13

File Edit Select Wiew Image Layer Colors Tools Filkers Fx-Foundry ScripbFu Video Windows Help
[ o

|px 2| 67%| :|pattern (3.7 mB)

Fig.1.10 Logo

The facility to copy all the layers that are visible in
a logo is available in GIMP. This tool is termed as Copy
Visible (Edit—Copy Visible). Try to copy the logo and
paste it on the canvas using this facility. Now, the
completed Logo will be visible on the poster.

In that case, how can we paste the text of the logo on
the poster?

| — =
‘ IS Bump map

Layer Palette of the logo (Fig. 1.11)? What happens if you
To view and hide a Layer | click on thisicon? When the picture of the eye disappears,
the layer on the logo window gets hidden. Try to copy
after hiding the layers other than the text layers. Don't
forget to use the Copy Visible tool when you copy the
L @AV Y O] text. Use the Move tool to arrange the pasted logo in the

Fig.1.11 Layer Palette suitable position. Click on the Save button to save the
changes made to the poster.

Haven’t you come across many instances in which a
layer once created on the poster had to be avoided? For
this, right click on the particular layer of the Layer Palette
and select Delete Layer.

GIMP is the graphic editor that includes many tools
which help in Image Editing. Let’s learn about some of
these tools that help in making the poster more attractive.

Activity 1.6 - Paths tool for selecting a picture

Paths tool is a tool that helps in selecting a part of an
image according to a fixed shape. Paths tool can also be
used to create different types of Patterns and also to select
a certain part of the image.

%
Information and Communications Technology - IX
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Suppose you have to separate only a part of the

picture (Fig. 1.12) and include it in the poster, how will
you do it? Follow the steps given below.

¢

Open the picture in GIMP.

Select Paths tool ﬁ'ﬁﬁ from the toolbox.

Click on the edges of the picture as shown in Fig. 1.12
Step 1.

Press the Ctrl key and click on the point where you
start to complete the marking.

Select From Path tool from the Select menu to mark
the path of the selected portion (Fig. 1.12 step 2).

Thus, the selection is completed.

Use the Copy — Paste tool to insert the picture in the
poster.

Adjust the size of the image to suit the poster and
save it.

‘g

& =
o 0 Sepeeoe -
[} TR L

P s e
(2| 125%) 2 Backgrobnd (119.0MB) o 2| $87% 2 Chld Laboerjpg (75 MB)

Fig.1.12 Various steps/stages while using Paths tool

i /

If the default settings in
GIMP is changed, there
are provisions available
in GIMP to reinstate the
default settings.

The following steps will
help you.

¢ Click on the Edit
menu in the GIMP
window and select
Preferences.

¢ Click on Window
Management in the
window that opens.

¢ C(Click on Reset Saved
Window Positions to
Default Values and
give OK command.

¢ Restart GIMP.

Information and Communications Technology - IX
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During image editing,
remember to close the picture
windows which you have
finished working.

Flip images

Provisions are available
in GIMP to flip the
images to either sides.
Follow the process given
below to do the activity.

¢ Make a copy of the
layer that includes the
picture to be flipped.

¢ Using the Mowve tool,
arrange the copied
image on the canvas.

¢ Click on the Flip tool
in the toolbox and
activate it.

¢ Click on the image
you intend to flip.

Layout of Pictures

Activity 1.7 - Change picture clarity

Imagine that you want to improve the clarity of a
picture you have selected to be included in the poster.

For this, first open the picture in GIMP and follow
the steps as given below.

¢ Make a the duplicate of the picture of which you
would like to change the clarity.

¢ Click on the Colors menu of the GIMP window and
open the Brightness - Contrast sub-menu.

¢ Move the slider in the window that opens. Change
the brightness and contrast of the picture. Observe
what happens.

Imagine that the picture of a boy who is engaged in
child labour is to be included in the poster. But the face
of the boy should be blurred. This was the problem faced
by Rithu. You might have faced the same problem. Let’s
do the activity given below.

Activity 1.8 - Filter tools

To make the face of the boy blurred in the poster
you have prepared, use the Blur tool in the Filter menu
in GIMP. Follow the steps given below.

¢ Select the layer which includes the picture that you
have to blur. (Click on the layer which has the picture
in the Layer Palette.)

¢ Using the selection tool, select the portion of the
picture to be blurred.

¢ Select a suitable blur tool from the Blur menu that
appears when you click on the Filters menu.

Now we can observe that the part of the image we
have selected is in a blurred manner.

Many filter tools are included in GIMP. Hope you
will use the other features available in the Filters menu.

Information and Communications Technology - IX 17
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Layout of Pictures

Now, you have almost finished the poster. To include
the completed poster in a presentation, export it in jpg
format and save it in the concerned folder. You have learnt
how to export a file in your previous class.

@k
. ;/ Let’s evaluate

1. Open a canvas in GIMP, paste a picture and anchor it. But, when you try to move
the pasted image, it moves along with the background. What could be the reason
for this?

a) The picture did not get pasted on the canvas.
b) The picture was pasted on the background of the canvas.
c) The Move tool did not function properly.

d) The picture format did not support the process.

2. Prepare a banner to be held in a rally to be organised in connection with the
proclamation procession of the World Environment Day. Include the details given
below and save it in your folder.

Hints:
+ Use Logo tool and include the slogan No forests No Man in an attractive manner.
* Include pictures that depict causes for the destruction of the environment.

» Save the banner in xcf and jpg formats in your folder.

3. From the procedures given below, choose the correct one which is used to rename

a layer in GIMP.
a) Click on the canvas. b) Click on the Layer Palette.
c) Right click on the layer. d) Click on the Floating layer.

4. Design a poster using GIMP to create awareness about the importance of organ
donation. Make use of the details given below.

Hints:
¢ Include a message in the form of a logo on the importance of organ donation.
¢ Arrange the pictures of the organs of the human body in an attractive manner.

¢ Export the poster in png format.
7
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Layout of Pictures

l%‘% Extended activities

¢ Your class is preparing a science magazine based on the unit Protectors of Biosphere
of your Biology textbook. The magazine explains the contributions of scientists
who explained the procedure of Photosynthesis. Prepare a cover page for the
magazine using GIMP.

¢ Design and exhibit posters in GIMP that highlights the message Cleanliness of the
surroundings is as important as Personal Hygiene.

¢ Organize a digital poster competition on the topic Wars Lead to Total Destruction.

PRY

%
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Chapter 2
Setting the Page

My seminar

paper

Vipin and Varsha are getting ready for a paper
is ready

presentation at a seminar to be held in connection with
the Vidyarangam Literary Fest. They are about to type
the written matter with the help of the computer and take
a print of it. Which software can they use for this?

You are familiar with the preparation of such files in
the word processor. Files prepared in this manner can be
arranged in various ways, edited, enriched and printed.
Just like Vipin and Varsha, we can also prepare a seminar Now, we shall

paper in the word processor in an attractive way. type this in the
computer and get

The first step is to type the seminar paper in the word
processor. You have practiced typing in the mother
tongue using word processor in your previous class.
Some of you may face difficulty in typing chillu letters
(chillaksharangal) and  compound  letters
(koottaksharangal). Let’s try to recollect how it was done.

Complete the following table by finding out the
letters used to coin the compound letters (Table 2.1).




MENDIIE Daldsln
1889-md nilayaniemadlo aomilaolm armila ey
COKIREITE GHemIRInag MmAEmad afpmle
cuaTumanlamimaem” mmgm’hel Y3 BT

k MWD D alehli. COlaEEm] aomad
mommad, agnilmd sanmlengenemand, glessomm
A, @SEEmMTlrns MBamm arg
Bl MU Ms, (B eduasglm feo seunilw)e
A JEIBEEDIT NN affEHEDHIRIERS RGN0 afignje
)T GRISE® EmImiwama DalgIm.
AR @e TyasnElan) @i jn DI6Ege Dl e
MREEleNT @RyAya DAEAZe AWM MUdaTl@myHED
MM laflSEmmogs UEdsERs GIEINeISHI M.
QE02alymd rusanlmyammlod oiknde mlew] muaanlomy
(Bl 230010 230MAF1EEID SSDN. QalQdin,
MU, MISdhe, 83U M0, Aleialeitys, RIEMUSIMY
afMlsmam @y D MENgEs DT,
mpmlaaimlinle)sn nm'lgsmga maules
iadall 2] Eoyla’ Al3yo8)3Tunk @SANDMEIW DNH

Fig. 2.1 An unformatted page

%
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Letter Compound letters
0] &>+ o+ D
QoY
XY
(@
DY

Table 2.1 Compound letters

Look at the following Table 2.2 and understand the
keys used to arrange ‘Chillaksharangal’.

2llH@OBUd

la

Table 2.2 Keys used to arrange “Chillaksharangal”

@
ad
ud
emd

@d

Type the following words.
B BoUB0B, @RAIND, ADNLE>U3, MEMald(@0, ®Iald:>@3.

Activity 2.1 - Let’s digitize the seminar paper

Open the word processor and type the content of
the paper. Don't forget to save the typed document. You
have learnt in the previous class how files prepared in the
word processor are given a name and how they are saved
in the concerned folders.

The picture (Fig. 2.1) shows the first page of the
seminar paper prepared and saved by Vipin and Varsha
just as you did. Doesn’t your seminar paper also follow
the same model? Now, observe the next picture (Fig. 2.2).
Here you will see that they have made many
improvements to the paper. What improvements have
they made? Note down your observations.

21
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Setting the Page

¢ Adjusted the size of the font.
QeIWIg Qe

¢ Changed the font. 19998 anajonflemosloll ssmiawd pmiatasly
il sowRaommIm®ma 3 opp@la  ImmIlgm]
e 3 L] A Daldbis.

¢ Adjusted the spacing between the paragraphs. snal asminadmoomod, asals semwlegy

seamand, gdescomp  assenh, mesloaaimes  ugdm
. SEIWIF  OaIQBOD  NTUONT,  BosEoudmgiel  ogan
¢ Provided background colour and borders to the | st sesgm smomw wrgpasiges oo
o o] miwIms 8. 3
page. MG oD gaWTD @ jm] LI,
URMMITUMIs  BYIEIAG MY LIEREge  DEamIs
Mgaanstang Ly BT s3Il MUTarTIim s mm
¢ MiasLmilaflsemmige nugdajpas £ D292 SR mne.
.............................................................................................................. T I s R R R
SRWIE  SIHSENELIE  SSTNNTE. B0, Mo,
¢ MISdke, @IUOIMa, OIENAISNLYs, QENLEILs afiTNlFIOMN
.............................................................................................................. B0 e (GO, ADYDIS AT oA aaSTGe
momloes pjanls) Segglal’ alsspmy. gsdmeasro
¢ amm

Fig.2.2 A formatted page
You might have learnt in the previous class, various
methods to edit letters and paragraphs. Now, in the
seminar paper you have typed and prepared, adjust the
font colour, font size, font style, line spacing, etc. so as to
make it attractive (as shown in Fig. 2.2) and save it.

Superscript and Subscript

You may come across situations where you have to type mathematical equations and
chemical formulae like a*+2ab+b? H,SO,. Have you noticed that in the terms a* and b? 2
is placed a little above the other letters? This is called superscript. Likewise in H, and O,, 2
and 4 are placed slightly below the other letters. This is called subscript.

To arrange letters and numbers, select them and select Superscript or Subscript from Text

in the Format Menu.

Activity 2.2 - Let’s layout the page

Just as the letters and paragraphs were formatted in
an attractive manner, the page also can be made attractive.
Open the Page Style window (Fig. 2.3) and examine the
facilities available there (Format — Page).

¢ Click on Page tab and type suitable values in the
Margin box to adjust the page margin.

%
/// 2y Information and Communications Technology-IX
7. 7 i Y o
/ o 1 s 7 NWWw.studiestoday.com



7 £ 4 Y 5 )
7///,',;,/%/4/242,5;4& D 0 i g //
0

Setting the Page

¢ You can select the page size from Paper
Format on Page tab. (Since our seminar

‘ document has to be printed, selecting A4 size
Orienzaban: g Partralt 15 preferable')

$iusiie
Textdiecton: | Lot hopontal) Peper iy [romptecsetoge]l  x . .
- I — ¢ Select either Portrait or Landscape from
Laft: 200em | = 4+ Pagelayaut Bt and left S . . . .
ma o wm -+ agernirs e = Orientation to set the page orientation
s evecie __ vertically or horizontally.
Botton: Zo0em | - 4 I |

Background colour can be given to make
e = (w s == | the page attractive. For this, select a suitable

Fig. 2.3 Page Style window colour from Area tab Color window of Page
Style and then click Apply — OK.

Activity 2.3 - Let’s provide borders

Don’t you think that the seminar paper will look more
attractive if we provide page borders? How can we do
s0?

¢ Click on the Borders tab in the Page Style window.

Shall I make the page ¢ From the Line Arrangement option you can select the
portion where you wish to provide borders.

morvttractive?
- ¢ Select Style, Width and Color to be given to the border
& from Line menu.

You can also adjust the spacing between the border
and the words here. For this you can select Spacing to
Contents and make necessary changes in the values in
Left, Right, Top and Bottom. By selecting a suitable style
from Shadow Style, you can also give a shadow to the
border.

Activity 2.4 - Let’s insert header and footer

Open your textbook and look at the top and bottom
portion of each page. Have you noticed the page number,
name of the book, name of the unit, your standard, etc.
appearing repeatedly on each page? Can we also include
such repeatedly appearing details (name of the seminar
paper, page number, etc.) in the pages of our document?

Information and Communications Technology-IX 7/ // 23 /////
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It will be convenient to include such repeatedly
appearing details in the Header and Footer. The
header appears at the top of each page and footer at
the bottom. Let’s see how the page number is inserted
as a header.

¢ Click on the Header tab of the Page Style window.
Put a tick mark in the Header on option and click OK
button. Now, the header will appear at the top of the
page.

¢ (Click on the header and insert the page number. (Insert
— Field — Page Number).

Now, examine the pages. Does the page number Picture as page
appear on each page? In the similar manner, insert as background
footer the title of your document on one page and the
name of your school in the next page. Just as we gave a colour

as the background, we

Did you face any difficulty in inserting different  can also give a picture as

contents as footer in the pages? the background. For this,

click Bitmap Area tab,

select the required

picture and click Apply
— OK.

After clicking Footer tab, ensure that there is no tick
mark on ‘Same content left and right pages’. Now, insert
the title of the seminar in the first page and the school’s
name in the second page as footer. Doesn’t the footer on
the left and right pages appear as you wished?

Activity 2.5 - Let’s arrange in columns

Observe how the content of the previous IT textbook
of Class 9 is presented (Fig. 2.4). The information is
arranged in two columns. Doesn’t this arrangement look
more attractive and impressive? Shall we arrange our
seminar paper also in this manner? What should we do
for this?

¢ Click on the Columns tab of Page Style window.

¢ Provide the number of columns required in the
Columns seen in Settings.

¢ Adjust the width and spacing of the columns using
the Width and Spacing option.

Information and Communications Technology-IX
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How can I set the
text in columns?
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Setting the Page

You have familiarised yourselves
with Internet and ways of collecting
information from Internet in Class VIIL
You also know how to open a website
using a web browser.

Open and see the website of
IT@School. What all do you see on the
home page?

Move the mouse pointer through
the home page.

Don’t you see a change in the shape
of mouse pointer when it reaches some
of the words and pictures in the home

page?

Click the mouse button where the
shape of the mouse pointer changes.
You can see new web pages opening.

In books and magazines,
information is printed on sheets of

paper.

Fig.2.4 A portion of ICT textbook

¢ Column width will be adjusted equally if there is a
tick mark against AutoWidth. But, if we remove the
tick mark we can adjust the width and distance of the
columns according to our requirement.

Now, arrange the text of the seminar paper in
columns and save it.

Activity 2.6 - When pictures are inserted

Don’t you think you should include pictures in your
seminar paper? You have learnt in earlier classes how to
insert pictures. Try to insert pictures in the same manner.
Insert Image tool in the Toolbar may also be used to insert
an image (Fig. 2.5).

Did you face any difficulty when you tried to insert
pictures in this manner? What was it?

il

Fig.2.5-Word Processor Toolbar
¢ Size of the picture is not suitable for the page.

¢ When pictures are inserted, the positions of the words
and sentences change.

How can we overcome such difficulties?

g
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¢ Select the picture. Some squares can be seen around
the picture. Click and drag on the squares to adjust
the size according to your requirement.

¢ To move the picture to the required position, click on
the picture and drag the mouse.

While inserting a picture, some words or sentences
may get displaced. This can be rectified using the Wrap
tool. For this, right click on the picture and select a suitable
Wrap style from the Wrap menu. If you wish to place
pictures between words, it is preferable to choose Page
Wrap or Optimal Page Wrap options.

You may have to include information related to the
seminar topic in a tabular format in your document. How
will you insert a table?

Activity 2.7 Let’s insert a table

You can use the Insert Table tool in the Tool bar (Fig.
2.5). Click on the Insert Table tool and provide the
required number of rows and columns. Now, haven’t you
inserted the table? (You can also insert a table in the order
Table — Insert Table.) But, you will find that in the table
you have inserted, all the cells are of the same size. How
can we format the cell size according to our need?

To adjust the width of the column,

¢ Bring the mouse pointer to the point where two
columns meet.

¢ The mouse pointer changes to a two sided arrow
(Fig. 2.6).

4 4 [ : 4 it
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Adjusting the size of
the picture

The size of the picture can
proportionately be
enlarged and reduced if
clicked and dropped at
the corners of the
borderline which are
seen around while
selecting the picture. The
height or width can be
changed by clicking and
dragging the other
borders of the picture.

=8

Adjust table column

Pic 2.6 Adjusting column space

N
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Setting the Page

¢ C(lick and drag the mouse and adjust the width as
required.

Now, try to adjust the height of the row in the same
manner.

Shall we merge the cells at the top of each column in
the table we have prepared and type the title there? At
times, we may have to merge more than one row or
column and add the information to it. How can we do it?

We can use the Merge Cells tool for this purpose.
Select the cells which we wish to merge and click on Merge
Cells in the Table menu. You will find that all the selected
cells have merged together. Now, you can type the title
there.

How can Iinsert
new columns and
rows in the table? Now, you can insert tables, according to your
requirement, in your seminar paper. You may have to
add more rows and columns in the table that you have
inserted. Do you know how to insert rows and columns
in the table?

Follow the steps to insert new columns,

¢ C(Click either to the left or right of the active cell. Select
Table — Insert = Columns.

¢ Thenumber of columns to be inserted and its position,
whether to the left or right of the selected cell, can be
entered here.

¢ Then, click on the OK button.

Now, you have inserted new columns. In the same
way, new rows can also be inserted and the matter can be
typed in it.

The seminar paper is now ready. Now, don’t you
want to take a print of it?

Your teacher has suggested that the print out can
be taken from the computer centre in front of the school.
But you found it difficult to open the file in the system of
the computer centre. How can this problem be solved? If
you export the file in the PDF format you will be able to
open it in any system that has the PDF viewer. How can
we change the document into pdf format?

7
Information and Communications Technology-IX / //
4 2117
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Activity 2.8 - Let’s convert and export as PDF
¢ Click Export as — Export as PDF in File menu.

¢ In the Range tab, from the window that opens select
whether you want to convert all the pages into PDF
(All) or only a few pages.

¢ Click on Export button.

¢ Select the place where you wish to save the file. Name
the file and save it.

Try to open the file in other computers. Can you open
it? Now, you can take the print out of the document and
present it at the seminar.

. Let’s evaluate

1. Identify the features of the terms given below and match them.

a) x> +vy? Header
b) Insert Page Number Subscript
c) HNO, Superscript

2. Prepare a show card in the word processor including the mathematical equations
(at+b)? = a?+2ab+b? (a-b)? = a*-2ab+b? to be exhibited at the Mathematics corner of
your school. Make it very attractive by giving page borders and background colour.

3. You have to insert the author’s name at the bottom of all the pages of an article
prepared in the word processor. Which of the following tools is the most suitable
for this?

a) Footer b) Merge Cells c) Insert Rows d) Header

4. Prepare in the word processor a notice for the inauguration of the school IT Club
and save it.

5. You have to merge the first three columns of a table in a file prepared in the word
processor and type a title in it. Which of the following tools can be used for this

purpose?
a) Delete Cells b) Merge Cells
c) Insert Columns d) Delete Columns

N
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.ﬁ Extended activities

¢ Prepare a show card in the word processor including the equations of motion
mentioned in your Physics textbook. Increase the font size, provide attractive colours
and save it.

¢ Prepare in the Word Processor the biographies of scientists like ] ] Thomson, Earnest
Rutherford and James Chadwick who are discussed in your Chemistry text.
Download the required pictures and details from the Internet.

¢ Create a table in the word processor that includes the atomic number, number of
electrons, and electronic configuration of elements with atomic number 1 to 18.

¢ Prepare a digital magazine in the word processor including the works of your
classmates. Make the magazine attractive by inserting pictures, providing
background colours, page borders, etc. Insert the name of the magazine as header
and page number as footer. Save it as PDF.

DRD

N\
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Chapten 5
The Infinite World Within Our Grasp

Amina and her friends of the science club of the school are preparing for a programme
A Day to Remember our Heart’ to be held in the school in connection with the World
Heart Day. They have to mail the details of the programme to an eminent cardiologist
who has agreed to deliver the keynote address. Being the Secretary of the club, Amina
is given the responsibility of sending the mail. But she does not have an email address.

How can we help Amina?

First of all, let’s
create an e-mail

We know that today almost all the activities of the
service sectors are Internet oriented. Today e-mail or
electronic mail address has become a necessity for all
online services. The following activity will help us to get
to know in detail how e-mail address is created and how

e-mails are sent.
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The Infinite World Within Our Grasp
E-mail

E-mail is the short form of electronic mail. It is the method of sending and receiving
messages through internet using the electronic media. In addition to messages, we
can also send and receive pictures, audio files, films, etc. through this. There are
service providers who provide e-mail facility free of cost. For e.g. Gmail, Yahoo
mail, Rediff mail. Messages sent through e-mail from anywhere in the world is
stored in the e-mail address of the receiver. You can open the mail using a password
and read the letters and other attached files from anywhere with the help of an
Internet connection.

What all preparations are to be made for sending an
e-mail?
¢ The Internet facility should be available.

¢ Both the sender and the receiver should have an e-

mail address.

Gmail is the e-mail service provided by Google.
E-mail address can also be used for other services of
Google. Let’s see how an e-mail can be sent by creating a
Google Account. Complete the following activities with
the help of your teacher.

Activity 3.1 - Let’s create a Google account
¢ Enter the site www.google.com

¢ Click on the link Sign In.

¢ Click on Create Account (Fig. 3.1).

¢ Enter your name and user name in Create your Google

Account.

¢ Enter the desired Password and Confirm Password
for your Google Account in the given boxes and click
Next.

¢ Enter your mobile number in Verify your phone

number window and then enter the Verification Code

received from Google.

Information and Communications Technology - IX V/ 31 /////
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The Infinite World Within Our Grasp

Google When you create an  e-mail account...
Signin

to continue to Gmail

If the E-mail ID that you desire to create has
already been used by someone else, you may
el or gt not get it. Then make the required changes and
give another address.

Forgot email?

An e-mail address has two parts - name given
Not your computer? Use a Private Window to sign in. by the user (user namE) al’ld the name Of the
Learn more . .

service provider. The two names are separated

by the symbol @.

For example: If a person named Joy Cheeran
registers in Gmail with the id ‘joycheeran’, his
e-mail address will be joycheeran@gmail.com
and if he registers in yahoo.in, his address will
Fistname be joycheeran@yahoo.in.

Last name

Google

Create your Google Account

to continue to Gmail

A person with the e-mail address of a particular

Usemame @gmail.com service provider can send to and receive mails
A from the mail address of any other service
Password Confirm password o pI'OVldeI'.

Use 8 or more characters with a mix of letters, numbers &

symbols

Signininstead

Google

Verify your phone number

For your security, Google wants to make sure it's
really you. Google will send a text message with a
6-digit verification code. Standard rates apply

Phone number

-

Fig. 3.1 Google Account application

¢ The account creation process can be completed by
agreeing to the conditions and privacy policies of the

service provider.

Information and Communications Technology - IX
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CAPTCHA

When internet services are used often you were asked

Prove you're not a robot

to type in a space, as shown in Fig. 3.2, while exposure @
p

providing your personal details to register for an e-
mail address. This is called Completely Automated

Type the two pieces of text:

Public Turing test to tell Computers and Humans c o8
Apart (CAPTCHA). It is a test to ensure that the user
isa Human Being. Websites generally use CAPTCHA i S (CAUFIICIRLE,

to protect the site from automated programs that are
used to hack the websites.

Then we can enter the gmail account using Username
and Password that we have created.

EER Now, you get an e-mail address.

When you enter the

- Open your e-mail account with the e-mail address
e-mail address...

and password that you have created.

T he e-mail f .
ype the e-mail address o ¢ When you open your account, the Inbox of Gmail

appears first. In this, you will find the mails sent by
Gmail welcoming you. You can click on it to open
and read the message.

the person/persons to
whom you wish to send the
mail in the column labelled
To. If you have to enter

more than one e-mail Now you have received your e-mail address. Let’s

address, use a comma to  go6 how e-mail can be sent using Gmail.

separate the addresses. If

you want to send a copy of  Activity 3.2 - Let’s send an e-mail

the e-mail to another
person, enter their e-mail ¢ Click the Compose button in the Gmail window.

address in the Cc column T h ., 1 add b dth
(Carbon Copy). If you ¢ ype. the rece1ve1js e-n?a1 a re'ss, subject arym the

detailed content in their respective columns in the
want to send a copy of the

mail to another person window that opens.

ithout the k led f ) . .
witho ) € _nc,)w © .ge © ¢ Click on Send button. You will receive a message that
the e-mail recipients in the

To and Ce column, enter your mail has been sent.

e preisors e el addiress There may be differences in the arrangement of the

in the Bee column (Blind facilities and buttons in the e-mail box of various service

carbon copy). providers. You may examine and find out.

Information and Communications Technology - IX \ 33
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The Infinite World Within Our Grasp

Activity 3.3 Let’s send a copy of the invitation

If you have to send a copy of the notice to the chief
guest, with details of the programme you intend to
organise in the school in connection with the World Heart
Day, what will you do? We can attach the notice to the

e-mail and send it.

To do this you need a digital or scanned copy of the
notice in your computer.

¢ We can select the files to be sent and attach them
following the instructions that appear when clicking
Attach Files Tools (Fig.3.3) in the New Message
window.

¢ C(Click on the Send button after you have attached the
files.

In the same manner, we can attach pictures, videos,
audio files, etc. along with the e-mail and send them.

7 — —
S S —
Fr— —

SansSerif ~ T~ B I U A~

mﬂ(@@@a . JC)

Fig. 3.3 Attach File Tools in Gmail

I‘-I
4

‘/

Ray Tomlinson
(1941-2016)

Ray Tomlinson was an
American Computer
Programmer who
developed the program
to send messages from
one computer to another
for ARPANET, which
was a precursor of the
Internet. He was the one
who selected the symbol
@ to separate the
username from the name
of the service provider in
the e-mail address. Even
now user@host is
considered as the
standard for e-mail
address.

Use of e-mail: Certain precautions...

¢ DPassword is the key to enter an e-mail box. Hence, it is safer to create a password
that contains capital letters, small letters, numerals and symbols.

¢ Itis good to change your password at intervals to keep your e-mail safe.

¢ Sign out of your mail account after you finish using it.

¢ If you receive mails, attachments, etc. from unknown or unfamiliar addresses,

you should open or respond to it only after ensuring

its credibility.

¢ Sending mails which include news, pictures or videos that are false, obscene,

cause defamation to people, or is a threat to national security, is a punishable

offence.

NN
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he Infinite World Within Our Grasp
Activity 3.4 Various modes of communication
You have learnt the importance and advantages of

e-mail. Now let’s compare the merits and limitations of
various modes of communication (Table 3.1).

Mode of communication Merits Limitations
Information can be Causes delay
Letter exchanged in the form of

text and picture.

Telephone Information can be Transmission of
exchanged in the form of | message happens very
sound. quickly.

Mobile phone

E-mail

Table 3.1 Various modes of communication

Not only service providers but also organizations and
government departments provide free e-mail facility for
official purposes.

For example the e-mail address of KITE is
contact@kite.kerala.gov.in

You have learnt how information can be collected
from the Internet and how e-mails can be sent. Almost
any information that we need like those related to literary
works, audios, videos, maps, etc. are available on the
Internet. Among the available versions of the online
encyclopedia, the more trustworthy and comprehensive
information is provided in Wikipedia.

You have already learnt the history and mode of the
functioning of Wikipedia in your previous class.
Wikipedia has many sister projects like Wikisource
(https:/ /ml.wikisource.org), Wiktionary (https://ml.
wiktionary.org), Wikiquotes for quotations ((https:/ /ml.

Information and Communications Technology - IX V/ 35 /////
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The Infinite World Within Our Grasp

wikiquote.org), Wikicommons (https://commons.
wikimedia.org), etc. Like Wikipedia, OpenStreetMap is
also a digital map that can be edited freely by anyone.

School Wiki

School Wiki (https://schoolwiki.in) is an
encyclopedia developed using Wiki software that
includes all details like history, location, etc. of schools
in Kerala. Giving information is as important as receiving
information. All these information about schools have
been contributed to this site by groups comprising
students, teachers and old students (alumni). Wiki
services have been developed in such a way that any
person can access the site, modify and add information
to it.

Wiki Projects/Services are a treasure trove of
regional knowledge. The information included in the site
is contributed by its volunteers. Depending on the
number of volunteers, the quantity of information
available in the collection may vary. Any person can
contribute to Wiki by either providing information or
editing the contents. People from all over the world and
all walks of life are volunteers in Wiki projects like
Wikipedia.

The fact that anyone, without much technical
knowledge can contribute or modify information,
makes Wiki projects more acceptable to all. You can
include details about your school, other interesting

features of your locality and also articles prepared by
children in School Wiki.

In the info box of the school page in the schoolwiki
(https:/ /schoolwiki.in) in the page Ente Naadu, details
of the following can be added:

¢ Geographical features of the locality.
¢ Natural beauty of the region
¢ Major job sectors

¢ Statistical data, tables and diagrams

| %et’s build the pillars
of knowledge

Wikipedia exhorts people
to ‘imagine a world in
which every single person
on the planet is given free
access to the sum of all
human
Content/information is
included in the wiki
projects through a
collaborative  effort.
Wikipedia operates on
the basis
policies and guidelines.
This lends clarity and
helps to bring consensus
when
differences of opinion.

knowledge’.

of certain

there are

+ Wikipedia should
have a neutral point
of view.

* Anyone can edit and
modify the content in
Wikipedia.

» Eventhough Wikipedia
has certain codes of
conduct, they are not
compulsory laws.

Information and Communications Technology - IX
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The Infinite World Within Our Grasp

To be a member of School Wiki...

Anyone is permitted to edit the contents in school

SCy
O 1 . . .
o wiki, but only those with membership have the
e B0 P .
S —— | permission to edit the secure pages and add new
Y
¥ o O ™ articles. Moreover, your contributions are saved either
RN IONGA B in your name or in your username. Your services to
o = : 1. . . .
S —— Wiki are evaluated on the basis of the contributions
— mongos pustiaaginia: malaa made and the pages edited using your username. To
- R get a membership, click on the link Create an account
A Sction W Ty e .
v on the main page. Type your username, password
ErusaTaERE. @anmujeunes’ midds deme .
- cvomagaes chrge ceteas and captcha and click on the Enter button. Now, you
efflassmaieciss T = . .
e s will get the membership. As soon as you have the
— o gos pennlst o, mkas membership, you can see your username written in

red at the top of the wiki page. Click on the red link
Create membership in School Wiki ¢, jnclude your personal/group details.

¢ Historical facts

¢ Institutions and organizations

¢ Eminent people and their contributions

¢ Developmental hallmarks and possibilities
¢ Heritage and tradition

¢ Artforms

¢ Language/dialect variations

Shall we include this information in your School
Wiki page?

Activity 3.5 Souvenir of Ente Naadu in School Wiki

¢ Login to School Wiki (https:/ /schoolwiki.in) and click
oninthe order, District, Education District and School
to reach your school page.

¢ Open the link Ente Naadu from the info box of your
school page (Fig. 3.5).

¢ Click on Edit seen at the top of the page. Provide the
information you have collected and click on Sawve.

Information and Communications Technology - IX V/ // 37 /////
Z Z Yrrrry
Downloaded from htt ] /
p 27 A %




4 4
/ / g! %723%%724%

7////

V

NN
N
NS\

The Infinite World Within Our Grasp

7Y 974777
s b i s o /
v, 4

sc,

{yinsn mach

b o8 il

anshens ga @it Aoma. Tkl sormia — a

o o i

.-w-,-.lﬂ.lj.m‘.l
iy flaos
kTt | Bl | TRl | asmmmem | acmus | e | ngoamangs
-;‘:lﬂc: | sauesas | m-\f-o | serdsarod | oo | d»:;ad | exmodsuand
sl
wam ikmpErmaR | @ G000 | Mmoesos! AlEETEmasUte | posie: nige | TEEEET MU0 T TUaTnom gLy
am o 2010 ayol ol
ik e gy s BT
crerims | seromeme | eamlaieomg, | dussmg. ainnal | anbmecd | o 2 oracd

el il g agend Dot

T R e T R nlpemesat @, sompmT
anmiemamEdgal qed | mcmand g 6 06T Pan@ey ST amogend el
margwla gro lspens Jr‘m» apfioe) i e ghisom ot

Fig. 3.4 Interface of a School Wiki page

¢ Theinformation required to organize
your article can be seen on the Help
page of Wiki.

¢ Wiki pages are written in a simple
way. Hence, anyone can become part
of this.

Wikiquotes

You have learnt the poem
Viswam Deepamayam written by
Ulloor S. Parameswara Iyer given
in your Malayalam textbook. Don’t you
remember the last lines of the poem?
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Creative Commons

Creative works like
photographs, music and
literature can  be
exchanged or
republished subject to
the Copyright Laws.
Often, complicated
copyright laws have
caused prolonged legal
battles. Creative
Commons is an
organization that works
to increase the
availability of creative
works that can be legally
shared. The organization
has released several
copyright licenses. As
these licenses are more
democratic and popular
than many  other
copyright licenses, the
Creative =~ Commons
License is the most
acceptable one for all
Wiki projects.
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The wiki projects which contain a collection of such
famous quotations, inspirational lines of poetry, proverbs,
riddles, idioms, etc. are the Wikiquotes.

Collect such materials from your textbook or from
the library and include it in Wikiquotes.

Activity 3.6 - Let’s add contents in Wikiquotes

¢ Type the URL https:/ /ml.wikiquote.org in the web
browser and press Enter.

¢ Login and type in the search box, the name of the
person/poet whose lines/poem you wish to add in
Wikiquotes.

¢ If these writers are already included in “Wikiquotes’,
the page consisting their quotations will open on the
screen.

¢ If the quotations or lines of a poem of a particular
writer is added for the first time, then a blank page
with the person’s name will open on the screen.

¢ Click on the Edit button that appears on the top of the
page. Now, add the portions that we wish to include
and save it. There is a facility to see a preview before
you save.

Do you know that you are free to use the content of
the Wiki projects without any payment. When you reuse
certain pictures or other materials from wiki, you must
remember to give due credit to the photographer/writer
as mentioned in the copyright license.

Creative use of Social Media

Social media have plenty of beneficial prospects. We
get to know the latest news and current affairs through




N

7

NN
\\\
N

The Infinite World Within Our Grasp

19445454 940000 4% ’4?4//44/2/9«’ //

Facebook, Twitter, WhatsApp and other online media. The information about your
school can be shared with more people using the Facebook page of your school. It
helps us share our own views and have social interactions with others. We can follow
the pages of famous writers, artists, scientists and also organizations like NASA and
ISRO through such social media. A lot of information is available through their blogs
and posts.

Disaster Management activities carried out by social media were unique during the
floods that occurred in Kashmir in 2014, Chennai in 2015 and our Kerala in 2018. The
SOS system of Twitter (the system that handles messages for help during disastrous
situations) saved many lives during the Kashmir floods. Many people made use of
the WhatsApp calls, the safety checks in Facebook, hashtag in Twitter and the
Person Finder of Google during the Chennai floods. The above mentioned systems
of social media and the Official Web Portal of Kerala helped to mitigate the intensity
of disaster during the Kerala floods to a great extent.

Disaster Management through social media

The social media groups can easily mobilize the manpower needed for disaster
management activities and to communicate the current status of the
victims of disaster to the people concerned. In disaster affected areas, where the
Internet and mobile towers are hardly available, SOS messages (making use of
system of SOS in mobile phones, SOS app, Ad-hoc network specially made to this
end) can be brought to the outside world through social media, thereby help
availing to the victims.

These social groups can mainly involve in the process of reconstruction subsequent
to the disasters. These media can play a major role in the coordination of food sup-
ply, fund raising and its distribution, and also they can make provision for the ser-
vices of skilled labourers for maintenance. During disaster,

e Strictly verify the authenticity of information and visuals received through
social groups before sharing.

e Follow and share urgent warnings and directions given by the government
through social and other media. Forward only the relevant and new messages.

e Make use of the official websites of government for further help.

e Instead of making calls, make use of SMS services to save the power of
battery of mobile phones.
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Cyber crimes

We have studied about cyber crimes in Standard VIIL. Illegal activities or
offences that are committed with the help of modern telecommunication networks
such as computers, mobile phones, Internet, etc. are termed as cyber crimes.
Exchanging or spreading messages, pictures or fake messages with an aim of
disturbing the privacy of a person, trying to defame a person or to threaten the
national security, through internet or any other social media, are grievous cyber
crimes.

Cracking: A malicious act of breaking into a computer or a computer network with
wrong intentions and tampering with the information in it is called Cracking.
Hacking, which examines the operating system or the software deeply and makes
drastic changes in them is often wrongly referred as Cracking.

Phishing: It is an attempt to acquire sensitive personal information like password
details, credit card details, etc. from a person through fake means.

Cybersquatting: It is an act of registering and using deceptive websites and address
by pretending to be the official websites.

Pornography: It is an act of exchanging, exhibiting and trading obscene contents
with pictures and videos.

Cyber Terrorism: The act of using cyber technology to threaten the security, unity
and supremacy of a nation.

Cyber Laws

The cyber law that came into effect in India on October 17, 2000 is the IT Act 2000.
This law was later amended in October 27, 2009.

This law gives an exhaustive account of the penalties and punishment to be imposed
for cyber crimes. The law is available in the link meity.gov.in/content/cyber-laws.

Small pictures or icons (smiley) used to express emotions

Emoji

commonly used in the social media and other online
communication facilities are known as Emoji. Be it happiness or
sorrow, tiny smiley like faces are used today in online to express
these emotions. Emojis convey our message more easily than a
text. There are all types of pictures in emojis.
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. Let’s evaluate

In the e-mail address alappuzha@yahoo.co.in, what is the name of the service
provider?

2. The encyclopedia which was developed using wiki software that includes details
like history, location, etc. of schools in Kerala is:

a. Wikipedia b. Wikisource c. School Wiki  d. Wikimedia Commons

3. The act of breaking into a computer or a computer network and destroying the
information in it is called -

a. Phishing ~ b. Cracking  c. Cybersquatting  d. Cyber terrorism.

lg‘% Extended activities

Collect information about various e-mail service providers and write a note about
the additional services provided by them.

¢ Collect information about various Wiki projects and conduct a seminar on behalf
of the school IT club.

¢ In the Vidyarangam Kalasahityavedi page of School wiki, include your creative
writing by categorising them as stories, poetry, articles, etc. Add pictures and make
it more attractive.

¢ Collect quotations, inspirational lines from poems, proverbs, riddles, idioms, etc.
from your textbook or from your school library and include them in Wikiquotes.

DRD
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Programming

Hello Robot, how
do you perform all
these functions?

The set of instructions
given to a computer is
called a program. Soft-
ware such as GIMP, Libre
Office Writer, Calc,
Impress, etc., with which
you are familiar are devel-
oped using different
programming languages.

I never think.
I just carry out the
instructions that are given to
me, that’s all...!

Like the robots, all software that you are familiar with
run on the basis of prior instructions given to them.

Don’t you remember how you prepared computer
games using scratch software in Standard VIII? In the
scratch software, various blocks were used to control
sprites. Did you realise that you were working on a
program that contained special instructions to move the
sprite while using each block?

So, we can conclude that a set of instructions
(programs) helps in the functioning of each software.

Let’s learn how such programs are prepared.

Downloaded from https:// www.studiestoday.com
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Programming

Programming languages

Can a computer understand all the instructions that
you give it directly?

The language that a computer understands is the
binary language.

Binary is a language that uses the two symbols 0 & 1 only, for
giving instructions.

Basically, a computer is an electronic machine. A
machine can understand only the presence and absence
of electricity. The presence of electricity is indicated with
1 and its absence is indicated with 0. The presence and
absence of electric pulses can be marked in the machine
using binary language. Therefore, binary language is also
called a machine language.

-

If the computer understands
only the binary language,
shouldn’t we convert all the
instructions to this
language?

But it is not easy to prepare instructions in the binary
language. Assume that a program spread over a number
of pages consists of only 0 and 1. Also imagine a situation
where this program needs to be corrected. Obviously it
will be a headache, right? That is how many popular and
easily comprehensible programming languages were
formulated. Python is such a programming language. C,
C++, Java, etc. are some other programming languages.

4

.,

7 za.://w/

Algorithm

While giving instructions
to a computer regarding
a particular function,
these instructions should
be arranged as minor sets
of activities. This is
called Algorithm which
is a step by step mode of
instruction given for
solving a problem.

You're right. Won’t
it be very difficult?

Information and Communications Technology - IX
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Python

Python is a very simple
programming language.
It has a simple syntax that
can be easily understood.
It uses very few symbols,
compared to programs
such as Java, C, etc.
Python was designed
under the leadership of
Guido van Rossum. This
software has Open
Source License. Many
software such as Blender
and Openshot Video
Editor, etc. have been

prepared in Python
language.
Translator programs

Translator programs are
used to convert the
programming language
to binary language and
to convert the
instructions in binary
language to  the
programming language.

Z
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But, how does the computer understand these
instructions?

The computer understands the instructions in these
programming languages with the help of a translator
program. See the picture given below (Fig. 4.1).

g a% "

onlo!‘-""'

hnlnllﬂlﬂ...

L1 o a1 0gq

print“Welcome”)

-

Translator program

Fig. 4.1 Illustration of translator program

In each programming language there will be a
translator program suitable for its instructions. This
program will take care of converting the instructions to
the machine language. But this translator program should
be given only those instructions that can be converted to
machine language. These instructions and the respective
translator program will be different for each programming
language.

Now, let’s get to know how a program is prepared
in Python language.

Activity 4.1 - Print statement

Let’s try to prepare a program statement to display
your name in Python language.

print(“Amina”)

In this program, print is the instruction in Python for
displaying the name, and the word in quotes is the word
to be displayed.

Try to perform the process given overleaf to run this
program.
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¢ Open IDLE3 from the Programming menu. The
Python Shell window will open.

¢ Type print(“Amina”) in Shell Prompter and press the
Enter key.

¢ Don’t you get the output in the Python Shell window
itself? (Fig. 4.2)

Python 3.6.6 Shell — L

File Edit Shell Debug Options Window Help

Python 3.6.6 (default, Sep 12 2018, 18:26:19)

[GCC 8.8.1 20188414 (experimental) [trunk revision 259383]] on linux
Type "copyright", "credits" or "license(})" for more information.
== print(“Amina™)

Amina

>>> |

Fig. 4.2 Python Shell window

Here, “Amina” is an English word, isn’t it? This is
not included in the word-list of the program. Such words
are called strings. You must have understood that to
display the strings, they should be given in quotes along
with the print statement.

Integrated Development Environment (IDE)

Text Editors can be used to write Python program
codes. A program that is thus written and saved, can
be run using a Terminal. For example, suppose a file
that contains a Python program has been saved as
pgml.py in your folder. In order to run this program
we need to open a Terminal from your folder and type
python3 pgml.py and then press Enter.

But there are several integrated software that help you
to write and run programs. They are called Integrated
Development Environment (IDE ). IDLE is a simple
IDE software. In Python 2 and Python 3 versions of
Python, there are slight variations in the word
arrangement structure. In this unit, Python 3 is referred.
We can use IDLE3 version for this.

Information and Communications Technology - IX
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Strings

A group of words,
letters, digits or symbols
can be called strings.
Anything thatis givenin
quotes (even if they are
digits), will be
considered as strings.

Variables

Variables can be used to
collect data. Variables
can be indicated using
either letters or words.
Numbers and strings
can be taken as values
for variables.
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Programming

Activity 4.2 - Practise program functioning in Python
Shell

Type each statement given below in Python Shell
and complete the table after observing the output.

Program statement Output

print(“Welcome”) Welcome

print(*“123”)

print(123)

print(8+9)

print(“g”+“9”)

Let’s learn more programs
Activity 4.3 - Let’s find the area

Imagine that you need to find the total area of the
playground in your school. You have found the length
and breadth of the playground. What should be done to
find its area?

Shall we give instructions for this to the computer?
Suppose the length is 80 m and breadth is 60 m.
Don’t you want to find the area?

If the variable I (length) is considered as length and the
variable b (breadth) is considered as breadth, we can
consider I =80 and b = 60.

If we indicate the area with the variable A , then A = 1*b.
Now, let’s display A.
How can we write this as a Python program?

=80 #length=80

#breadth=60
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Programming
=|* =
A=I*b # area = length x breadth Comment
print(A) # display value of A

Run each statement of this program in Python Shell.

Don’t you think that it is difficult to run everything
at one stretch?

Shall we create a new file and run this program?

Open a new file from Python Shell window (File —
New File). Type the program in the window that opens
(Fig. 4.3) and save it in your folder. While saving give a
suitable name to the file.

Area.py - [home/suresh/Area.py (3.66) — 0O &
File Edit Format Run Options Window Help
| 1=860 -
|h=ﬁﬂ
A=1%*b
:printEA]

Fig. 4.3 Window for typing Python program

Don’t you wish to run the Python codes that you have
prepared?

We can run this program by selecting Run Module from
the Run menu. The output of this function can be obtained
from the Python Shell window. Run this program once again.
What answer do you get? You will get the same answer even
if you run this program many times. What is the reason for
this?

There is a The length of the
playground ne playground.in
my house. Its my school is

length is 50 m 100m. Its
and breadth is breadth is 60m.
40 m.

-

The comment for each
statement in Python
program can be added
after # symbol. The
comments that are added
in the same row after #
symbol will not be
considered while
running the programme.

Don’t forget to include
such comments in the
programs you prepare.

File extension

The extension of Python
files is .py. When Python
files are stored in IDLE
software they get saved
with a .py extension.

Information and Communications Technology - IX
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Programming
o5 If you wish to find the area using different
Interpreter and measurements, with the help of this program, what are
Compiler the changes to be effected?
There are mainly two ¢ The value for length (I) and breadth (b) should be
types of translator given.
programs called

The Python instruction that is given for this is

Interpreter and Compiler .
eval(input()).

which are used to convert
the instructions in the

) ¢ Try to run this program.
programming language

into machine language. I=eval(input())
Interpreter converts each

statement in the program b=eval(input())
into machine language.

But in Compiler the whole A=Ib
program is changed into

machine language. print(A)

Give different values to I and b while you run the
program and press Enter. Don’t you get different values
for the area, corresponding with changes in the
measurements for length and breadth?

But here, the person who works on this program does
not have any clues as to what measurements should be
given as input or what result should be obtained as
output.

We can give the hint for this along with the input
statement and the print statement while writing the
program. Take a look at how the program has been written
after effecting the changes detailed above.

|=eval(input(“Enter length of the rectangle:”))
b=eval(input(“Enter breadth of the rectangle:”))
A=Ib

print(“Area of the rectangle=",A)

What changes can you observe while working with
this program compared to what was written earlier?

Z
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Programming

Activity 4.4 - Let’s combine strings

Let’s try to create a program which tells that you are Combining strings
a student of your school if you give the name of the
school. If string is the value that should be given while
the program is running, give input() in the place of
eval(input()).

While displaying more
than one string using
print statement and
while displaying the
strings and the value of

s=input(“Enter your School’s name:”) th ables toeeth
e variables together,

print(“You are a student of”,s) the strings and the
variables should be
Activity 4.5 - Use of mathematical exercise separated using comma.

Prepare a program that gives the sum total of the
angles of a polygon if the sides of a polygon are given.

Suppose assigning the name of the polygon is in
variable “a” and the number of the sides is in variable
u ” thel‘l,

The sum total of the angles is s = (n-2)* 180. This has
to be found out and the value should be displayed.

a=input(“Enter the name of polygon:”)
n=eval(input(“Enter number of sides:”))
s=(n-2)*180

print(*Sum of angles of “,a,” is “s)

You have practised the use of strings and finding
solutions to mathematical problems using Python
program. There may be several situations in which you
have to take different decisions by examining a value.
Let’s perform an activity in which we can handle such
situations.

Activity 4.6 - Examining the score

Prepare a program that helps you know whether you
got selected for the district level competition, when you
enter your score for the school level quiz competition.
(Imagine that only those who scored above 80 are eligible
for the district level competition).
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Programming

Conditional Statement if... else What all instructions should be given for
this?

el oy el The score that is given while running the

can be us‘edi to check whgther d program should be considered as a
statement is right or not and instruct variable. (Imagine a as the variable). For

what should be done if the statement this the statement eval(input()) can be used
is correct and what should be done if for this.

the statement is not correct. Take a
look at the indent for the statements
used after if, else.

¢ Examine whether you have scored above
80. To check whether a statement is
correct, a conditional statement can be

_ Wil irimbneashbd x=® used in programs. Here, using the
Flle Edit Format Rum Options Window Help .. . .
2meval (input ("Enter your score: *)] X conditional statement if you can examine
LT 2>80: whether a>80.

print("Congratulations, You are selected")
else: : :
print("Sorry, You are not selected”) ¢ When this _statement is correct,
“Congratulations, You are Selected” will
Fig. 4.4 Program using if..else statement be displayed.

How will the program be?

a=eval(input(“Enter your score:”))
if a>80:

print(“Congratulations, You are Selected”)

What happens if the score given is 80 or below when
the program is running?

Nothing is displayed as output, right?

That s, if the statement that you examine is incorrect,
you will not get an output. Therefore, this can be
expanded to an if... else statement.

When the statement is correct, “Congratulations, You
are Selected” should be displayed and when the statement
is incorrect, “Sorry, You are not Selected” should be
displayed.
a=eval(input(“Enter your score:”))
if a>80:

print (“Congratulations, You are Selected”)
else:
print(“Sorry,You are not Selected”)

You have learnt how different values are given to
different variables. Now, let’s familiarise ourselves with
the Python statement to indicate a group of values.

Z
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Programming
range
In Python language (range()) is used to indicate a group of values.

range(10) indicates 10 numbers lesser than 10. Here, the starting number is 0 and 1 is
considered as the increase. Therefore, the numbers will be 0,1, 2,3, 4,5, 6,7, 8, 9.

range (I, 10) indicates 10 numbers lesser than 10, starting from 1. Here, the increase is
1. Therefore, it willbe 1, 2, 3,4, 5,6,7, 8, 9.

range (1,20,2) indicates odd numbers that are lesser than 20, starting from 1. Here, the
increase will be 2. Therefore, it will be 1, 3,5, 7,9, 11, 13, 15, 17, 19.

Activity 4.7 - Find the numbers using the range instruc-
tions

Attempt writing down the numbers denoted while using
the following range instructions.

Instructions Denoted numbers

range (3, 100, 5) 3,8,13,18, 23, 28....ccciiiiiiiiin 83, 88, 93, 98

range (0, 50, 10)

range (50, 0, -10)

range (2, 20)

range (15)

These instructions can be typed in Python Shell and
you can find the numbers that are denoted if you run the
program.

While running Python Shell instead of range(),
indicate list(range()).

Don’t you want to check whether your answer is right
or not?

You are now familiar with the range() statement that
indicates a group of numbers. Let’s learn how range() is
used in situations where one or more actions are repeated.
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for loops for repeated
instructions

When a statement or a
group of statements need
to be repeated in a
program, it can be
included ina loop. A loop
statement that is used in
Python is called for loop.

Observe the program
given below.

for i in range(l,I1):

print(i)
This is a program to

display whole numbers
from 1 to 10.

In for loop the print(i)
statement runs when the
variable i is given values
1,2,3,4,5,6,7,8,9,10.

That means, the different
values of i is displayed 10
times.

Did you notice the indent
when you used the
repeated statements in
for loop?

7
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Activity 4.8 - Let’s repeat the activities

You know how to display your name through the
statement print(*Amina”) (Activity 4.1). What instructions
will you give, to display the name 20 times?

As the statement print("Amina") has to be repeated 20
times, it can be included in a loop. So, we can write the
program like this:

for i in range(20):

print(“Amina”)

Here range(20) indicates 20 values such as (0, 1, 2, 3,
4,5,6,7,8,9,10,11,12,13 14, 15,16, 17, 18, 19). When the
variable i is given to each value, the statement
print("Amina") starts functioning. Therefore, when i gets
the value 0, the name Amina is printed. When the next
value is given, (i=1), again the name Amina is printed.
We can conclude that, the name Amina will be printed
when i is given any value within the range. Thus the word
is printed 20 times.

Activity 4.9 - Displaying numbers

Suppose you need to create a program to display
the even numbers from 2 to 100. For indicating the
numbers, you may use the range (2, 101, 2). You can give
different values to variable k and then display.

for kin range(2,101,2):
print(k)

While Loop

A loop statement used in Python is called while loop.
When we use while loop instead of for loop, the
statements that indicate the starting value of the
variable and the increase of the value have to be
indicated separately. Look at how a program in for loop
has been converted to while loop (Table 4.1). What
differences can you see?

7 53 ////
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Programming

for loop while loop

for kin range (2, 101,2): | k=2
print (k) while k<101

print (k)
k=k+2

Every time when the value of k is increased by 2, then k = k+2 is used.

Table 4.1 Program in which while loop is used instead of for loop

. Let’s evaluate

1. What will be the output (value of a) of the following program?
a=2
a=a+3
print(a)
a.b b. 6 c. 2 d.3

2. Which among the following is used in Python to indicate numbers from 1 to 20?

a. range(20 b. range(1,20 c. range(l,21) d. range(1,21,2)
g

3. foriin range(l,5):
print(“Welcome”)
How many times will Welcome be displayed in the output of this program?
a.5 b.4 c. 2 d.1

4. a="3"
b= “2”
print(a+b)

Information and Communications Technology - IX
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Programming
What will be the output of this program?
a.b b. 6 c. 23 d. 32
5. Anu wishes to prepare a program to display the value of numbers from 1 to 25. The

program that Anu prepared is given below. There are some errors in it. Can you
edit the errors?

s=0

for i in range(25):
s=sti

print(s)

.g-* Extended activities

¢ DPrepare a Python program to display the multiples of 7 below 200.
¢ DPrepare a Python program to find the sum of the even numbers from 2 to 50.

¢ DPrepare a Python program to display the multiplication table upto 20 by giving a
number as input.

%
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Chapter 5
The Practical Lab in Computers

-

We live in the wonderful age of information
technology. There has been a great leap in the world of
technology which is an offshoot of the incredible rate at
which the whole world is progressing. We can make use
of the various facilities offered by information technology
to make learning and activities related to it, more
effective. Nowadays many educational software are
available in our computer as a scaffold for learning
activities. You are already familiar with learning activities
using different software. In this chapter, you will be
acquainted with some simulation software that helps you
to comprehend and assimilate complex ideas in an easy
manner.

Drifting Continents...
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The Practical Lab in Computers

"...Long before the lizards, before the dinosaurs, two spores set
out on an incredible journey. They came to a valley bathed in
the placid glow of sunset.

My elder sister, said the little spore to the bigger spore, let us
see what lies beyond’.

The Legends of Khasak
(O.V. Vijayan)

How was this green earth formed even before the
lizards and dinosaurs reigned over it? Continents and
oceans were formed when lithospheric plates floated on
top of asthenosphere that was partially in liquid form.
You have discussed this phenomenon named Continental
Drift in the chapter titled “The Signature of Time” in your

Let me watch the Social Science textbook. Such natural phenomena can be
formation of

continents ... will use

carefully studied in detail by using simulation software.
an o, We can observe this with the help of GPlates software

w that is included in GNU/Linux by IT@school. GPlates ,
J which is a Free software has the facility to observe the

formation of tectonic plates over the years, the
reconstruction of tectonic plates and their shifting through
different periods, with the help of simulation.

Activity 5.1 - Formation of continents

Let’s see how continents acquired their present form
through continental drift with the help of GPlates
software.

¢ Open GPlates software.

¢ Open the folder Shapefile in the Gplates Project folder
in Home, through Open Feature Collection in File
Menu. Click Open after selecting all the files (also by
Ctrl+A) in the folder.

You may note that the Layer window also opens

along with the main window (Fig. 5.1).

7
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File Edit View Features Reconstruction Utllities Tools Window Help
6

urrent Feature

e Animation
Controls
Layers 1
¥ Add new layer » o |&
b - Seton_etal_ESRZ012_2012.1
R &r sLlu tl Jr Trx:t

- Seton el.al Esazou -nes 201:_.1 Polygun
Reconstructed Ceometries
* Inputs
Reconstructable features:
Seton_etal ESR201...2.
Add new connec
Reconstruction trae:
Add new connechion
Tool Palette St : Topology surfaces:
View Controls e

‘OB DO

1_Polygon.gpmiz =

%

= Reconstruction options

Wiew: | 3D Orthographic {tat; 0.00; lon: 0,00) Mouse: (lat: 29, 31 . -
1 Reconstruct using topologies:
% | tlicked ' Topolagy Sectlons ® No
= | T Yes B setperameters | @
Feature type PlateID HWame Clicked geometry Begin End Created Presg iz

Flll polylines

Fig. 5.1 GPlates Main window

¢ Click on Toggle Visibility (indicated by the sign of an
eye) in the Layer window; you can either show or hide
each layer.

¢ If the Layer window is not visible, click on Show
Layers in the Window menu of Main Window. @

¢ You can select the Drag Globe tool and freely move )
the globe, using the mouse or the Arrow keys.

¢ While using other tools in the Tool Palette, you can
press the Ctrl key in the keyboard and move the globe.

GPlates

GPlates software was developed by the scientists in the School of Geosciences in the
University of Sydney as part of their EarthByte Project. Using this software, we can
observe the transfer of the position of tectonic plates in each period, due to continental
drift. The visualisation and analysis of Raster Images in GIS is possible in GPlates.
All the data files in GPlates software are called Features. Such data files that can be
opened through the software are called Feature Collections. When we open the
software we can see a globe that can be turned in any direction any number of times.
GPlates does most of its activities and analysis by including the feature collections
of geological features which were either downloaded or created with the help of this
software.

/ 58 Information and Communications Technology - IX
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Projection in many
ways

Animation can be viewed
in different projection
forms such as 3D
Orthographic, Rectangular,
Mercator, Mollweide,
Robinson, etc. which are
there in View Control seen
at the bottom of the main
window. You can restore
the window, by a click on
the Leave Full Screen
Mode on top of the
window.

Animation backwards

The continental drift
animation can be viewed
in two ways, i.e. from the
ancient period to the
modern era and vice
versa. Click on the
Reverse the Animation
option  from the
Configure Animation in
the Reconstruction menu.

7
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¢ Tosee the geographic plates in different colours, click
on the Triangle on the left side of the layer named
‘Seton_etal_ESR2012_Coastlines_2012.1_Polygon’ in
the Layer Palette and give a tick to the check box
named Fill Polygons.

¢ Click on Configure Text Overlay in View Menu. Then
the Enable Text Overlay window will open. Give a tick
to this window and see the duration of continent
formation. This is measured in Ma (1 Mega Annum=1

million years) unit.

¢ Select Full Screen in Window Menu and run the Play
the animation button.

You have seen the wonderful visual of how various
continents reached their present position after so many
evolutionary stages of coming together and drifting apart,
over the years. Watch the animation once again, keeping
the continents in the globe against you. Seven mega
lithospheric plates which have an area of several thousand
square kilometers and some minor ones like Philippine,
Cocos, Nazca, etc. have been clearly identified. You know
that the drifting of these plates to different directions is
the basis of all major geographical processes. Haven't you
understood that continents moved apart due to tectonic
pressure and that the modern concepts of nations and
international border were but human constructs?

Let’s save this activity.
¢ Click on Save Project from the File Menu.

¢ Now, name the file and save it in your folder.

The unique file format of GPlates project is gproj.
The projects once saved can be opened through Open
Project in File Menu.
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The Practical Lab in Computers

Activity 5.2 - Let’s find volcanoes

You know that the boundaries of tectonic plates are

active with volcanoes. We can view volcanic areas with
the help of GPlates.

¢

Use Open Feature Collection to open ‘volcanoes.gpml’
file from the “Creating Features” which is saved in the
Gplatesproject folder in Home. The small yellow
squares that are seen in the globe indicate volcanoes.

To show the boundary of plates in the globe, include
the feature collection ‘Seton_etal ESR2012_Coastlines
_2012.1_Polygon.gpmlz’ from Shapefile folder in the
‘Gplatesproject” folder.

Now, save this in your folder.

Did you understand that volcanoes are found in the

boundaries of tectonic plates? To understand more about
volcanoes and boundaries of plates,

¢

Select tool in the order Feature Inspection — Choose
Feature in the Tool Palette.

Click on the coastline, volcanoes, etc. on the globe.

Now, you can see their details on Current Feature
which can be seen on the right side of the window
(Fig. 5.2).

Make use of this and prepare an

observation note.

0 ////////4

Where are

volcanoes mostly
found?

GPlates L

File: Edit Wiew Features Eecorsiroction Utlities Tools Window Help
Ll @ K ow bl bt @ | B | S reamie
Activity 5.3 - Let’s export GPlates -+ [ e
projects &
Sy
You may wuse the export » 1
technique to convert the simulations ? Sy
in GPlates software to graphic mode. 3
. . »
Let’s see how the ‘Ring of Fire’ area
in the Pacific plate can be exported
Wiew: | 3DOrthographic 2 | | 100% (o 317 ; e 77 807 Mase (a0 6599 lon: 174.39) (olT globe)
in svg format (Fig. 5.3). 8 [ iekos | mpiomyBestions
. Feabwreype Plate D Mame Clicked geometry Begin  End Created Present-day gec
‘ Open the file that was Saved in gpmiCoastine 502  SriLamka gpmbcenterlinen! 600  Futwre 1 minuteago  polgen: (721310
Activity 5.2. Fig. 5.2 Visualisation of volcano in GPlates

0
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The Practical Lab in Computers

e ———— * ¢ Arrange the Pacific plate in the globe (Fig.
@ (@ e U e o, 5.3) in such a way that it faces you.

¢ ‘Ring of Fire’ is an area in Pacific Ocean
which appears like a belt active with
volcanoes.

Sl JRCE ARRE

Click on Export in Reconstruction menu
and then select Export Single Snapshot
Instant from the window that appears.

.74 ; lon: 105.61) [off globe)

o reame

Zakhalin
gomliunclasdfiedFeaturs 0 KOLOKOLG gpenluncla
gomkCoastline &24 _ Sakhalin apemlcenterd

Begin  End  Created
600 Fubure S manut

" w we i ¢ Select Add Export. Click Projected
Geometries (and Rasters) from Choose
Data Type. Click SVG from Choose
Output File Format and relevent resolution and give
file name in Specify Output Filenames. Click OK.

Fig.5.3 GPlates image of ring of fire

¢ Select the folder in which you intend to save the image
from Target Directory and press Export Snapshot.
Now, the image will be saved.

Add Data to Export

1. Choose Data Type to Export 3. Configuce Export Options

EETEETITETTTES
Projected Geometries (and Rasters) >
3

Colour Raster

Numerical Raster

Scalar Coverages

Deformation

Velocities

Resolved Topologies (General)
Resolved Topologies (Citcoms specific)
Relative Total Rotation

Equivalent Total Rotation

Relative Stage Rotation

Equivalent Stage Rotation 4. Spedh

Flowlines : ; -
Template: |volcanoes .5vg

Motion Paths
Co-registration data . S ) )

Net Rotations A filename template uses printf-like format strings to specify where the
changing per-frame values should appear in the filename.

Image Resolution
i 2 S Height:| 426 3

| Constrain aspect ratio Use main window dimensions:

%n frame number, in the range [1, N]

%u  frame index, in the range [0, (N-1)]

%F reconstruction time of frame

%d reconstruction time of frame (rounded to integer)
%A anchor plate id

%R  default reconstruction tree layer name

Export projected geometries (and projected %D  date format "yyyy-MM-dd”
raster) data. %T time Format "hh-mm-ss"
2.C put File Format The precision of %Ff and padding of %d may be customised using printf

conversion specifiers (For example, "%0.2f" or "%02d"). %n and %u will be
padded automatically to the width of the highest value.

CLICK HERE | Cancel

| e

///
2777 /’g’{,

Fig.5.4 Add data to Export window
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The Practical Lab in Computers
Export in two ways

The visuals that are viewed in GPlates can be exported through Export Time Sequence
of Snapshots and Export Single Snapshot Instant methods. Export the animation in
Activity 5.1 using Export Time Sequence of Snapshots and save it in your folder. You
will use the images that you get for slide presentation, when you learn about the
presentation software.

. Let’'s evaluate

¢ What is the unique file format to save a project in GPlates software?

1) gproj 2) gpml 3) svg 4) png

¢ Include Shapefile feature collection in the software and sequence the Continental
Drift period as 200 Ma. Locate the position of South America and Africa and save it
in svg format.

lﬁ Extended activities

¢ Include the Feature Collection Working with Mid Ocean Ridge from GPlates Project
Folder and devise the formation of submarine mountain ranges through simulation.

B N N

An aid for learning geometry

You have learnt many facts about parallel lines in
your Mathematics textbook. If you wish to confirm these
facts through experiments how many lines will you have
to draw to find out the measurements and their
characteristics? We have studied the GeoGebra software
in the eighth standard which helps to effectively construct
geometric figures and effect some changes in them. Shall
we use this software to prove certain facts?

Activity 5.4 - Let’s draw parallel lines

¢ Open GeoGebra software and draw the line AB using
Line Tool.

¢ Mark point C using Point Tool, near to this line (Fig.
5.5).

7
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Various kinds of
Windows

By marking a tick mark
in the View menu of
GeoGebra window, you
can include perspectives
such as:

Algebra View
Graphics View
3D Graphics View
Spreadsheet View
CAS View

according to your wish.
When you click on each
View, the respective
tools will be displayed.

Dilation

Dilation Tool can be
used to increase the size
of an object and its
distance from a point in
a fixed rate. If you click
on the object to be
dilated and the point
that is considered as the
base after selecting the
tool, you will get a
window. If you give the
Dilation Factor which is
the number that indicates
the number of times, the
distance should be
increased and give OK
you will get the new
object in the prescribed
size and distance.

7
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How can we draw a line through point C, parallel to
the line AB?

Act 5 5.qgb -0

File Edit View Options Tools Window Help

Ny 1 e e Y [ s e S 2

o o o

w T e

L ]

2y

]nput:|

Fig.5.5 Parallel lines

¢ Select the Parallel Line tool.
¢ C(lick on the point C and on line AB.

Give a suitable name to this construction and save it
in your folder.

What will you do if you want to draw another line at
the same distance? How many times would the distance
of this line be from AB? We can draw a line like this at a
particular distance using Dilate from Point tool in
GeoGebra.

Activity 5.5 - Draw a parallel line at a particular distance

It will be two times the distance from A to the line
that passes through C. Let’s do this activity.

¢ Select the Dilate from Point tool. Then, click on the
line through C and on the point A using the tool.

¢ Give2as Dilation Factorin the window that appears.

%
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The Practical Lab in Computers
Haven’t you got a new line that you wanted? (Fig.
5.6)

Now, dilate the line that passes through C three times
and draw another parallel line. What is special about the
four lines that are seen there?

Save the activity in your folder.
Activity 5.6 - Find speciality of parallel lines

Let’s draw a line segment that intersects the four lines
you have constructed. For this,

¢ Mark one point each on the first and the last line using
the Point Tool.

¢ Join them using the Segment Tool as you see in
Fig. 5.7.

Don’t the parallel lines intersect this line segment?
You can use the Intersect tool in GeoGebra to find the
points of intersection.

¢ Select the Intersect Tool and click on one of the parallel
lines and the line segment. Didn’t you get the points
of intersection? Mark other points of intersection like
this.

¢ Mark the length of each part using the Distance or

Length tool. Are the lengths equal?

Change the position of the end points of the line
segment using Move tool. What specialties do you notice?
Note them down.

Let’s mark the point of intersection

You can mark the points of intersection of two geometric
figures by a click using the Intersect Tool.

N

N

7

7

- n‘/ ': o "

Bl ool

7 2559

Axk_§_dagh

File Edit View Options Tool

Input:

Fig.5.6 Equidistant Parellel
Lines

At 5 64gb
File Edit View Options Tools Windaw Help

3

oy |

i R gl I ot

Fig.5.7 Line Intersecting
Parallel Lines
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The Practical Lab in Computers

We have learnt how to draw circles of a given size in
the eighth standard. What should be done to adjust the
size and shape of a geometrical figure? We can use the
Slider tool in GeoGebra for this.

Let’s make Slider

Slider is a tool in GeoGebra that is used to control the
value of a variable that indicates a number or a
measurement of an angle. Select the Slider Tool and
click on the GeoGebra window. A window like the one
you see in Fig. 5.8 will appear. The values of the Slider
can be arranged as real numbers, measurement of
angles or integers, according to your wish. For this, you
need to press on the radio buttons Number, Angle or
Integer respectively and select any of them. The Slider
will appear when you give the name of the Slider, after
entering the maximum value and increment, click OK.
You can adjust the value of the Slider by dragging or
using the arrow keys after selecting.

Activity 5.7 - Let’s draw a circle that can be adjusted
using Slider

@Iore software for Suppose you wish to construct a circle of which the
learning Mathematics radius can be adjusted from 1 to 5. First of all, you have
to construct a slider for this.

There are many software
which come under the
group of software like
Interactive Geometry
Software (IGS) and
Dynamic  Geometry
Environment (DGE). slider *
Geometric Supposer,
which was formed in the
1980s was the first of this
kind. Drawing Geometry ~ ~ '"€9¢"  CRandon
(Dr. Geo), K Interactive (

¢ Select the Slider tool and click on the window. A
window will appear as you can see in Fig. 5.8. It is
the radius of the circle that has to be adjusted. For
this, the Number Slider has to be selected. Don’t you
notice the name of this Slider?

® Number Narie

i Angle _ |a |

"Interval | Slider | Animation |
Geometry (Kig), CaRMetal,

Min: (1 Max: |5 Increment:
etc. are free software | | | |

whereas Cabri Geometry,
Cinderella, etc. are ‘ oK H Gancel |
proprietary software.

Fig.5.8 Window for creating a Slider

s’///
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The Practical Lab in Computers

¢ When you enter Min : 1, Max : 5 and click OK, Slider Let’s oi i mati

will appear. et’s give animation
To give animation to the
objects in GeoGebra
window, right click on
them and put a tick mark
to Animation On in the
¢ Move the slider using Move tool. You can observe check box. You cannot

that the radius of the circle changes according to the give animation to all

value of the slider. objects. Animation can be

given to objects that move
Try to give animation to the Slider. What should be i 4 fixed path. (e.g. A

done tp see the circles fo? each.value of th.e slider at the point on a circle or a line).
same time? You need toright click on the circleand puta [ 5 gslider is given

tick to Trace on. animation, the objects
that are controlled by it
also get animation.

¢ Click on the window after selecting Circle with Center
and Radius tool. In the window where you have to
provide the value of the radius, provide the name of
the slider you have already constructed.

@ >

i
¥4 Let’s evaluate

1. Imagine that using the Slider you have drawn a figure in GeoGebra. Which tools
are to be used simultaneously to see the figures having different values in the
Slider all at once?

(@) Zoom In
(b) Trace on
(c) Animation on

(d) Intersect

2. Do the following activities using GeoGebra and save them in your folder after giving
suitable names.

¢ Draw two parallel lines. Find the distance between them and mark them.
Hint: You can use Perpendicular Line, Intersect, Distance or Length tools.

¢ Construct triangle ABC in the given measurement. AB =5 units, AC = 4 units, BC =
3 units.

Hint: The tools such as Segment with Given Length, Circle with Centre and Radius,
Intersect can be used.

Information and Communications Technology - IX
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The Practical Lab in Computers
l QJI Extended activities

¢ Draw each figure given below using GeoGebra. Select the part that includes the
figure and export them in image format (File-Export).

2 o
N Y

(i) (ii) {iii) {iv) fv) fwi)

* %k %k k% %

Through the Stellar Sights

You have understood the use of Education Software
in Geography and Geometry. Let’s get familiarized with
some simulation software which are useful in the learning
of Science. In the study of Astronomy, sky gazing is very
important. We have limitations in observing stars and
planets in the sky always. Stellarium is a simulation
software which generates Virtual Reality of the sky. By
adjusting the location and time in this software, you can
observe the sky from any location at any time. You can
reproduce interesting and wonderful stellar aspects in a
clear and simple manner through Stellarium software.

Activity 5.8 - Let’s use the Stellarium software

¢ Open the Stellarium software.

¢ When you bring the mouse
pointer to the left side of
the main window, you get
the Tool bar and when you
bring it to the bottom, the
Status bar will appear
(Fig. 5.9).

Location window [F&]

Date;time windew [F5]

Configuration window [F2]

¢ By aclick on the triangles
that are seen at the place
where the status bar and
tool bar joins, you can fix
Status Bar them on their respective
Fig.5.9 Stellarium - Main window places.
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Astronomical calculations window [F10]

Tool Bar

Help window [F1]
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Activity 5.9 - Let’s adjust the location

The area of sky that is visible to us will be different
when we observe space from various locations. If the area
of the sky from a particular location should be made
visible, the location has to be specified in the software.
For this, follow the activities given below.

You can click on the Location window (F6) tool seen
at the top part of the tool bar.

You can click on the location in the map that appears
in the window that opens and adjust the view of the sky
from there (Fig. 5.10). You can also select from the list of
locations given in the software. If necessary, click on the
Reset Location List.

Activity 5.10 - Let’s observe constellations

Location

Fig.5.10 To adjust the location of observation

Adjust day and time

Click on the Date/Time window
(F5) (Fig. 5.9) in the Toolbar to
observe the sky at a particular
time on a particular day. Click
on the Triangular buttons in the

Date and Time

2006 f 1 |

Add a new location

We can include places in
the Location window that
are not in the list of places
in Stellarium. Enter the
details of the location
latitude,
longitude, the name of
the location and country
in the relevant boxes seen
below the Current
location information (Fig.
5.10). Then, click Add to
list button and close the
window. (no need to
make changes in the
Altitude box).

such as

Date and Time

Jullan Dy

12 : o : 2

Fig.5.11 Adjust day and time in the software

Date and Time window (Fig. 5.11) and change the day and time.
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The Practical Lab in Computers

You have seen a lot of stars in the sky. Stars appear
in the sky as particular groups or constellations. These
constellations are considered by us as imaginary figures.
Let’s see how we can observe such constellations using
Stellarium software.

¢ Open Stellarium software.

¢ C(lick on Constellation lines (C), Constellation labels
(V) and Constellation art (R) (Fig. 5.12) tools that
appear in the Status bar.

To watch the sky which is boundless, click on
Ground tool in the status bar (Fig. 5.12).

Constellation lines

i = ey STelml=]
Constellation labels Night mode

Ground
Constellation art Atmosphere

Earth, Kochi, | Om FOV B0 ™

e e -

Fig.5.12 Stellarium status bar

¢ Enter the name of the constellation that you wish to
view and their imaginary shape in your notebook.

Activate Atmosphere tool (Fig. 5.12) in the status bar
to view the space clearly during the daytime.

Suppose you want to see the constellation Leo
(Chingam) through this software. For this,

¢ Click on the Search window (Fig. 5.9) in the tool bar.

¢ Type Leo in the Search box (Fig. 5.13) in the Object
tab that appears and then click on J&8.

Object

¢ Zoom using Page Up, Page Down keys or using the
Scroll button of the mouse.

Search box

DLED TS T ¢ Observe carefully the Leo constellation (Fig. 5.14) by
dragging the mouse or using the arrow keys in the

Fig. 5.13 Stellarium Search keyboard

Window

7
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The Practical Lab in Computers

¢ Find the name of the star that appears when you click
on each star in constellation Leo and complete Table

5.1.

You know that the sun is the closest star to the earth.
You have learnt that the earth revolves round the sun,
while it rotates by itself. Because of the revolution of the
earth, a person who observes the sun from the earth may
feel that the sun is moving in a particular path. This path
is called an Ecliptic Line. Shall we observe the Ecliptic

Line through Stellarium Software?
Activity 5.11 - Let’s find the ecliptic line

¢ Click on Sky and viewing options window tool
(F4) (Fig. 5.9) in the tool bar in Stellarium
software and reach the View window.

¢ Click on Ecliptic (of date) (Fig. 5.15) in the
Celestial Sphere list of Markings tab and close
the window.

¢ Zoom using Page Up and Page Down keys or
the Scroll Button of the mouse.

¢ You can bring the Ecliptic Line in the range of
visibility either by dragging the mouse or by
using the arrow keys in the keyboard.

Fig.5.15 View window

4

Fig.5.14 Leo (Chingam), the
constellation

SI. No. Name of the Star
1 Regulus
2 Denebola
3
4

Table 5.1 - Stars in Leo constellation

el Uel

When  you select
Malayalam from Sky
Culture Language in the
Main tab of Configuration
Window (F2) in the tool
bar of Stellarium Software
and close the window, the
names of constellations
will appear in Malayalam.

Information and Communications Technology - IX
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The Practical Lab in Computers

Fig. 5.16 - Ecliptic line

¢ Identify and list the constellations in the Ecliptic Line
using Constellation Lines (C), Constellation labels (V)
@ and Constellation art (R) given in the status bar.

l Let’s evaluate

¢ Onwhich tool should you click to display the imaginary form of Orion constellation
in the Stellarium software?

F"

Kg(

a. Constellation labels b. Constellation art
c. Constellation lines d. Azimuthal grid

¢ Which function helps to fix the Tool bar and the Status bar in the window of
Stellarium software in their respective positions?

a. Click on Ground button.

b. Click on Configuration window.

c. Click on the triangles that you see where Status bar and Tool bar joins.
d.Click on Ocular view button.

.Lé-ﬁ Extended activities

Make changes to the time of observation in the software and find the constellation
in which the sun appears in the Ecliptic Line on January 1.

¢ Observe Polaris with the help of the software and find in which constellation it is
found.

* %k %k %k %

7
Information and Communications Technology - IX //

Downloaded from http




% / < 7
/ 7/”/(’,1/%’@,&’2’3‘@ ;'z;’/?/?ﬁée?/;'/ o 08055 /"’4 ’4?'5//44‘2/ V //

7

_

N

The Practical Lab in Computers

From charcoal to gem brightness

You have learnt in your Chemistry textbook the
phenomenon called allotropy which explains how an
element appears in various physical states. Carbon atoms
combine with each other to become molecules in cyclic
forms or chain forms. In nature, we can see carbon in
different forms from charcoal to diamond. This is because
of the difference in the configuration of atoms in
molecules. Is it possible for us to find how atoms are
configured in molecules? You have practised various
activities in ghemical software on the ways to prepare
models of simple molecules and to observe their three-
dimensional structure in the computer in your eighth
standard. Which are the compounds, the models of which
were constructed by you using ghemical software in your
eighth standard?

¢ Water (H,O)

¢ Carbon dioxide (CO,)

We have done the construction and observation of
molecules with a simple structure. We can observe
molecules with a complex structure using RasMol
software included by IT@school in GNU/Linux.

Diamond, Graphite and Fullerene are the allotropes
of Carbon in crystal form. A lot of carbon atoms are
combined in it. The pdb files of such complex molecules
are available on the internet. Download the pdb files of
Diamond, Graphite and Fullerene with the help of your
teacher and save them in your folder. Files of this kind
can be used for your learning purposes.

Activity 5.12 - Observe the molecular structure of
Fullerene

¢ Open RasMol (GTK version) software.

72

4

RasMol

RasMol is a software
developed by Roger Sail
to observe the three
dimensional structure of
molecules (http://
www.rasmol.org). The
three-dimensional form
of molecules will be

shown in different
colours in the graphic
screen of RasMol

software when we give
the basic facts as file
input. Usually extension
files named protein data
bank or .pdb are given as
input.
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The Practical Lab in Computers

¢ Open the pdb file of Fullerene molecule using File —
Open. The Wireframe model of Fullerene molecule
structure will be visible.

¢ To convert this to Ball & Stick model, select and click
on the Ball & stick in the Display menu.

¢ Using the mouse, turn the molecule and observe how
carbon atoms are combined in it.

Suppose you want to find the number of carbon
atoms in a Fullerene molecule. What is the way out?
Follow the process given below.

¢ When the Command prompt (F7) in the View menu is
activated, the Terminal window appears below the
Graphic Screen window.

¢ When you type ‘select carbon’ in the Terminal window
and press the Enter key, the number of carbon atoms
will be shown (Fig. 5.17). Then type ‘color yellow’.
Don’t you see that the carbon atoms turn yellow? What
will you do to give some other colours?

Activity 5.13 - Observe the molecular structure of dia-
mond and graphite

Find out the pdb files of Diamond and Graphite
Fig.5.17 Molecular structure of molecules which are allotropes of Carbon, using RasMol

Fullerene software and complete Table 5.2.
Characteristics Diamond Graphite
Shape of the molecule | Three-dimensional network Hexagonal Layer
Combination of One atom of carbon
carbon atoms combines with other four
carbon atoms

Table 5.2 Difference in the molecular structure of diamond and graphite

Though only carbon atoms are contained in Diamond
and Graphite, the configuration of atoms in their
molecules are different. This is why their physical
properties appear to be different.

7
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The Practical Lab in Computers

RasMol - diamond.pdh oo RasMol - graphite.pdb - 08

File. View Display Colours: Gptlons Sertings: Help

File View Display Colours: Options  Setkings. Help

Fig. 5.18 Molecular Structure of diamond and graphite

@k
. ;-’/ Let’s evaluate

¢ Which of the following files can be used to observe the molecular structure of a
substance through RasMol software?

a). pdf b). pdb ). png d). ppt

.‘léJT Extended activities

¢ Collect pdb files of various molecules from the internet and observe them using
RasMol software.
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QL Lctsinowaboutoybersafety I

There is absolutely no need to mention the advantages of Internet and Social
Networking sites. We have embraced their potential for communication,
entertainment and information seeking.

But over the period, it is seen that a lot of teenagers are being harassed and fall
prey to the abuse of Social Media. You can easily prevent yourself from being
avictim, if you take a few precautionary measures while being online.

» How Social Networking sites can be dangerous

* Sharing and posting too much of personal information such as phone
number, address, location, photos, etc., can be misused.

 Trusting strangers believing their profile to be true can be dangerous, as they
may not be the same as stated.

* Snapshots of chats, photos, videos, etc., are saved and will be used for
blackmailing and threatening.

» Being cyber bullied by posting negative, derogatory comments, posts, photos,
etc. to tarnish one's image.

* Lots of predators and adult criminals are lurking online to trap children.

» Tips for safe Social Networking

+ Always keep your personal information strictly personal.

 Customize your privacy settings so that others can see only the basic information.

* Justknow about and manage your friends. Don’t trust all the online friends.

* Let your friends know that you are uncomfortable if they post something
inappropriate about you.

* Do not publish any information that reveals your identity.

+ Always use strong passwords. Don’t share them with others.

* Never share your pictures, photographs, email accounts, etc., with anyone.

» Keep your personal messages strictly personal. Once posted they are published
for ever.

» Ifeverthreatened or bullied seek the help of parents/teachers.

Helpline Phone Numbers

Crime Stopper: 1090
Cyber Cell (Tvm): 9497975998
—] Control Room: 100 —
Child Helpline: 1098 / 1517
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